
 

 

License Agreement 
  

Grant of License 
Odyssey grants you the right to use one copy of the included Odyssey software on any single mobile device, provided 
the Software is in use on only one mobile device at any time. The Software is in “use” on a mobile device when it is 
loaded into temporary memory (i.e., Program memory) or installed into permanent memory (i.e., Storage memory) of 
that mobile device. In addition, you may install and use one copy of that portion of the Software that is identified as 
“On-Schedule Sync for Windows CE” on the single desktop computer you use to synchronize data with the system. If 
you have multiple Licenses for the Software, then at any time you may have as many copies of the Software in use as 
you have Licenses. The number of persons using the Software or users of the Software should not exceed the number 
of Licenses. This agreement will be constructed and governed in accordance with the laws of the State of California. 

Copyright Notice 
 Copyright 1992-2003 Odyssey Computing, Inc. 

Information in this document is subject to change without notice and does not represent a commitment on the part of 
Odyssey. The software described in this document is furnished under a license agreement. The software may be used 
or copied only in accordance with the terms of the agreement. It is against the law to copy the software on any medium 
except as specifically allowed in the license agreement. The purchaser may make one copy of the software for backup 
purposes. No part of this manual may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying, recording, or information storage and retrieval systems, for any purpose other 
than the purchaser's personal use, without the express written consent of Odyssey. 

Limited Warranty  
If the software is provided on record able media, Odyssey warrants that the disk(s) upon which the software is 
provided is free of defect in material and workmanship for a period of 90 days from the date of receipt. In case of such 
a defect, Odyssey will replace the defective disk(s). If damage to the disk(s) is caused by accident, misuse, or abuse, 
Odyssey will assume no liability whatsoever. 

Except for the expressed warranty set forth above, Odyssey grants no other warranties, expressed or implied, 
by statute or otherwise, regarding the disks and related materials, their fitness for any purpose, their quality, or 
their merchantability. The liability of Odyssey under the warranty set forth above shall be limited to the 
amount paid by the customer for the product. In no event shall Odyssey be liable for any special, consequential, 
or other damages for breach of warranty. 

Trademark Acknowledgment 
Products listed are trademarks or registered trademarks of their respective owners. 
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1 
Introduction 
Congratulations on acquiring the latest version of Pocket On-Schedule and On-Schedule Sync  the 
finest Contact Manager available for the Microsoft Windows CE platform. Pocket On-Schedule enables 
mobile professionals to have full control of their contact information anytime, anywhere! Pocket On-
Schedule is a versatile standalone contact manager that combines state-of-the-art features for professionals 
on the go. Pocket On-Schedule directly synchronizes with Microsoft Outlook and Desktop On-Schedule. 
Pocket On-Schedule does it all – Quickly, Simply, and Efficiently. 

Odyssey Computing provides complete solutions for mobile device users. Refer to Other Odyssey Software 
Products on page 3 for more information. This document only describes the synchronization process 
between Pocket On-Schedule and Microsoft Outlook 2000 or higher on the desktop PC.  

Important: If you are using desktop On-Schedule, please download the desktop On-Schedule Sync User’s 
Guide from our website at www.odysseyinc.com. 

On-Schedule Sync 
On-Schedule Sync lets you transfer and share data in order to keep your contact information organized and 
current on your desktop and your mobile device. Pocket On-Schedule allows full bi-directional 
synchronization (with conflict resolution) of contacts, calendars, tasks, journal, and notes with Microsoft 
Outlook.  

 
NOTE: Info Center and Phone log synchronization is only supported with Desktop On-Schedule 

This document covers the synchronization process that updates data files on both the desktop and mobile 
devices.  

Synchronize Microsoft Outlook 2000 or higher with Pocket On-Schedule using On-Schedule’s custom 
synchronization manager, On-Schedule Sync, with enhanced features such as multiple contact lists, 
calendars, task lists, journal lists, notes, and filters. See the following sections.   

Important: You will need to establish a connection to the mobile device using Microsoft ActiveSync before 
running the On-Schedule Sync setup. 

You can also download the latest versions of the On-Schedule Sync from the Odyssey Computing website 
at www.odysseyinc.com. 

With the On-Schedule Sync applications, you will be able to synchronize one desktop PC with multiple 
mobile devices. Presently, you are not able to synchronize one mobile device with multiple desktop PCs.  
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Features Overview 
This section summarizes the powerful features available in Pocket On-Schedule.  

Compatibility  • Compatible with Desktop On-Schedule 
• Compatible with Microsoft Outlook 2000 or Outlook 2002 

Desktop 
Synchronization 

• Automatic and bi-directional synchronization (with conflict 
resolution) of multiple contact lists, calendars, task lists, journal, 
and notes. 

• Supports conflict resolution at the field level  
• Advanced record selection using filters  

Registration 
As a registered user, you will be informed of new products and updates as they become available. You will 
also be eligible for special discounts on software upgrades. Technical support is only available to registered 
users. To register, please fax us a copy of your receipt together with your name, address, phone number 
and e-mail address. Also, feel free to contact us if you have any comments or suggestions. 

Reaching Us 
Mailing address: 

Odyssey Computing, Inc. 
17075 Via Del Campo, Suite 200 
San Diego, CA 92127 

Phone Numbers: 
Sales   (858) 675-3660 
Technical Support  (858) 675-3775 
Fax Number  (858) 675-1130 

Internet: 
 Product Info  info@odysseyinc.com 

 Sales e-mail  sales@odysseyinc.com 
 Support e-mail  support@odysseyinc.com 
 World Wide Web  http://www.odysseyinc.com 
 

You can also post messages on the Odyssey Computing Forum at www.odysseyinc.com/forums. This 
allows you to exchange information and ideas with Odyssey Computing and other On-Schedule users. 
You can access the forums through our website at www.odysseyinc.com. 
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Other Odyssey Software Products 
Contact Management Software 
♦ Desktop On-Schedule  
On-Schedule for Windows 98/SE/ME/NT/2000/XP is a versatile, 32-bit network-ready contact manager 
that lets you organize information efficiently. On-Schedule is the ideal desktop companion to Pocket On-
Schedule as it allows you to automatically and bi-directionally synchronize contact history, multiple 
contact lists, calendars, task lists, notes, journal, calls and documents. On-Schedule provides extensive 
tracking of phone calls, enhanced mail/fax merge functions, direct e-mail and Internet support, integration 
with other popular applications, and comprehensive document management. The latest features include 
Custom Filters, Microsoft Fax and TAPI Support, Internet and Microsoft Exchange Integration, E-mail 
Merge, Contact Information Templates, Record/History Summary, Ad-hoc Links, Mobile Device 
Synchronization, powerful Windows style Wizards, and more.  

Calculator Software 
♦ Pocket and Desktop BizCalc 
BizCalc is an intuitive, full-featured programmable business and financial software that emulates the 
popular Hewlett-Packard HP-12C calculator. Using RPN logic, it performs the following calculations as 
well as others: Loan/Mortgage, Discounted Cash Flow (NPV, IRR), Bond, Compound Interest, Leasing, 
Actuarial and Markup Functions, Depreciation, Amortization Schedule, making it the premier financial 
calculator software. It also incorporates a powerful tape display that can be annotated, date/time stamped, 
and saved for later use. BizCalc is an indispensable tool for business, retail, finance, banking, real estate, 
and leasing industry professionals.  
Available: Pocket BizCalc for Windows CE (Mobile Device, Handheld PC, Pocket PC, and Desktop 
BizCalc for Windows 98/SE/ME/2000/NT/XP 

♦ Pocket and Desktop MBA-Calc 
MBA-Calc is an advanced, full-featured Algebraic business and financial calculator. MBA-Calc operates 
like the Texas Instruments BA-II Plus handheld calculator and incorporates many of its features and a 
number of additional ones. MBA-Calc features algebraic equation entry and prompted dialog box and entry 
fields for all financial and statistical calculations, making it unnecessary to memorize function key 
sequences. Results of calculations can be pasted into other applications. MBA-Calc is also an indispensable 
tool for business, retail, finance, banking, real estate, and leasing industry professionals. 
Available: Pocket MBA-Calc for Windows CE (Mobile Device, Handheld PC, Pocket PC) and Desktop 
MBA-Calc for Windows 98/SE/ME/2000/NT/XP. 
 

Code: 2L18
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2  
System Requirements 
This chapter covers the system requirements for On-Schedule Sync and Pocket On-Schedule v5. 

System Requirements 
• For the mobile device:  

• Any Handheld PC running Windows CE 2.11. 
• Most mobile devices running Windows CE 3.0 or Windows CE.NET 
• Processor support for Xscale, StrongARM, MIPS, X86, SH3/4 
• Complete installation requires up to 4MB of storage memory and 6MB of application memory 

depending on configuration 
• The number of records that can be stored depends on the available RAM storage size 
• Serial port, USB, IRDA connection to desktop PC required for synchronization. 

• For the desktop PC:  
• Any PC with Pentium or higher microprocessor 
• 3.5” floppy disk drive or CD-ROM 
• 32 MB of RAM 
• VGA monitor or higher 
• 2 MB of available hard disk space for installation 
• Microsoft Windows 98/SE/ME/NT 4.0/2000/XP with Microsoft ActiveSync 3.1 or higher 

installed 
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3   
Getting Started 
Important: You will need to install Microsoft ActiveSync 3.1 or higher before you run the On-Schedule 
Sync setup. The Microsoft ActiveSync setup may be available from the CD-ROM that was shipped with 
your mobile device or you can download it from the Microsoft website. Please refer to the ActiveSync 
Help files for detailed instructions on how to install and run ActiveSync. 

How to make a Microsoft ActiveSync connection. 
To establish a connection between the desktop PC and the mobile device 
When you connect your mobile device to the desktop using a sync cable for the first time, ActiveSync will 
automatically attempt to connect the desktop PC and mobile device. A window will be display give you a 
window asking to set up a partnership or set up the device as a guest. If a connection is not automatically 
made, you can connect the desktop PC and mobile device manually by: 

1. Starting ActiveSync on the desktop PC.  
2. Clicking on File > Get Connected.  
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If you are connecting for the first time, the following New Partnership Window will be displayed asking to 
set up a New Partnership for the device or as a Guest.  
 

 
  
  

1. You can either click on Yes to set up a partnership or No to set up the device as a Guest. If you 
want to set up a partnership, click on Yes and then type in a name for the device in the next 
window. Then click on Next when you are asked to Select Synchronization Settings. 
Synchronization settings will be set in the On-Schedule Sync application. Then click on Finish to 
complete the ActiveSync partnership setup. You should see the following window. The green 
circle on the right indicates that the device has been connected successfully to the desktop. 
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If you have created a partnership, you will not have to go through the ActiveSync initialization 
screens each time you connect the device to the desktop.  

2. The Guest connection is only a temporary connection. Once the device is disconnected and 
reconnected, the New Partnership Window will be displayed and you will have to repeat the above 
steps again. 

Installing On-Schedule Sync 
Make sure that your device is connected successfully to the desktop PC before running the setup file for 
On-Schedule Sync. The Sync setup will install files on your desktop PC and copy some files to the mobile 
device. If your device is not connected when you run the setup, those files will be copied over the next a 
connection is established between the mobile device and the desktop.  
To install On-Schedule Sync on your desktop PC, double click on the h2ksyncoemsetup.exe file. The 
name of the Sync setup file that you are provided may be different. If you are unsure of the correct setup 
file to run, please visit our website at www.odysseyinc.com to download the latest setup file. 
Follow the instructions on the windows that appear on your desktop PC after you have launched the setup 
program. It is recommended that you choose the default settings during the installation.   
During the setup, you will see the following screen.  
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• Check the Outlook Menu and Toolbar Options box if you would like to install On-
Schedule Sync menu and Toolbar icons into Microsoft Outlook. 

• Check the ActiveSync Menu Options box if you would like to install On-Schedule Sync 
menu options into Microsoft ActiveSync.  
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If you have checked the Outlook Menu and Toolbar Options box, On-Schedule Sync setup will install an 
On-Schedule Sync menu together with an On-Schedule Sync icon  and a Synchronize Now icon  in 
Microsoft Outlook. 
 
 
 

 

Running On-Schedule Outlook Sync  
To launch On-Schedule Outlook Sync: 

1. Click on Start > Programs > On-Schedule > On-Schedule Outlook Sync  
OR 

2. Click on the On-Schedule Sync icon  in Microsoft Outlook. 
OR 

3. Click on On-Schedule Sync > On-Schedule Sync Manager in Microsoft Outlook. 
 
To launch On-Schedule Outlook Sync and synchronize automatically using your predefined settings: 

On-Schedule Sync Menu On-Schedule Sync Icons 
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1. Click on the Synchronize Now icon  in Microsoft Outlook. 
OR 

2. Click on On-Schedule Sync > Synchronize Now in Microsoft Outlook. 
 
The first time you run On-Schedule Sync, you will see the following window: 

 
Click on Yes to proceed. The On-Schedule partnership keeps track of the items to be synchronized 
between the desktop PC and the device.  You can create multiple On-Schedule partnerships between one 
desktop PC and multiple mobile devices.  However, you will not be able to create multiple partnerships 
between one mobile device and several desktop PCs.  
 
The On-Schedule Outlook Sync for Windows CE main dialog box will have the following three tabs: 
• An Options tab for specifying preferences for conflict resolution.  
• A Folders tab which lets you select and map the folders to synchronize. This tab displays all the 

available databases and folders and lets you specify your preferences and database selection before 
you start the synchronization process. 

• An Email tab, which allows configuration of items to be transferred between Pocket On-Schedule and 
Microsoft Outlook.  
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4 
Options Tab 
This tab has options on when and how to perform synchronization. It allows you to set up preferences and 
customize On-Schedule Sync to handle data conflicts. When all your settings have been finalized in other 
tabs, click on the Synchronize Now button to start synchronizing data back and forth. 
 

 

Status 
• If your mobile device is properly connected, the Status box will display this message: “Connected 

to Mobile Device”. 

• If your mobile device is not connected, the Status box will display this message: “Waiting for 
device to connect.” 
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• Data can be synchronized automatically or manually. If the Automatically synchronize upon 
connecting box is checked and a connection is established between the mobile device and the 
desktop PC, On-Schedule will automatically synchronize any pre-selected folders. In addition to 
an ActiveSync Partnership, On-Schedule Sync will work even if the device is connected as a 
Guest.  

• If the Stay open after successful synchronization is checked box is checked, this dialog box will 
remain open after synchronization is completed. 

• The Conflict Resolution settings let you set the default actions in the event of a data change 
conflict. This conflict occurs if the same field for the same item has changed on both the mobile 
device and on the desktop. For more information on Conflict Resolution, see page 14. 

• You can click on Synchronize Now to start the synchronization of the folders that have been 
selected and mapped to the mobile device.  

• Click on the Settings button to display the Partnership Properties. 
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• Click on the Connection button to view the connection settings for the device. 

 
 

• Click on Explore to view the files on the mobile device and to copy files between the device and 
the desktop. 
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Conflict Resolution 

 
On-Schedule Outlook Sync for Windows CE provides several options for resolving conflicts. A conflict 
happens when the same data field has been modified on both the desktop and the mobile devices. Conflict 
resolution ensures that your information is always accurate and up-to-date, no matter how many times you 
transfer items. There are two ways to handle data conflicts. You can handle data conflicts interactively by 
being prompted for an action or have On-Schedule Outlook Sync automatically handle the conflict without 
prompting you.  
 

NOTE: Since synchronization is at the field level, there is no data conflict is the same record is 
changed on both the desktop and device but on different fields. For example, assuming 
Joe Smith’s phone number was modified on the desktop while his e-mail address was 
modified on the device. During synchronization, you will not be notified of a conflict 
resolution for his record. His new phone number will be automatically transferred to the 
device and his new e-mail address will be transferred to the desktop.  

Manual Conflict Resolution 
To resolve conflicting items interactively: 

1. From the Options tab, check the option Prompt me, and set the following as the default action. 
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2. From the default actions list, change the settings to reflect your preference: 

   Desktop item to replace the Mobile device item.  

   Mobile device item to replace the Desktop item. 

   Skip and don’t replace either item. 
3. Once you are satisfied with your settings, click Synchronize Now to carry out the actions you 

specified.  

NOTE: In this configuration, you will be given the option of changing which item is replaced 
when a conflict occurs. When the Conflict Resolution dialog box appears, the above 
action will be set by default for all conflicting items. 

Automatic Conflict Resolution 
To automatically handle data conflicts: 

1. From the Options tab, check the option Don’t Prompt me, and always.  
2. From the default actions list, change the settings to reflect your preference: 

  Desktop item to replace the Mobile device item.  

  Mobile device item to replace the Desktop item. 

  Skip and don’t replace either item. 
3. Once you are satisfied with your settings, click Synchronize Now to carry out the actions you 

specified.  

NOTE: In this configuration, you will not be given the option of changing which item is replaced 
when a conflict occurs. The conflict will be resolved automatically without ever 
displaying the Conflict Resolution dialog box. 

Resolving Conflicts 
If On-Schedule Sync is configured to prompt you in case of data conflicts, the Conflict Resolution dialog 
box will appear when data conflict occurs during synchronization: 
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The following is shown in the Conflict Resolution dialog box: 
• The description of the record being processed. 
• The name of the database that contains the mobile device record being processed. 
• The name of the folder that contains the record being processed. 
• A list of all conflicting fields for the record currently being processed. For each conflicting field, 

the field name, the mobile device value, and the desktop value are displayed. 

To resolve conflicting items: 
1. For each field in the list, click the icon to the left of the field name to choose the appropriate action.  

When the dialog box first appears, the default action is displayed. See the Options Tab section on 
page 14 on how to change the default action. 
The following actions are available: 

  Select this action to replace the Mobile Device item with the Desktop item. 

  Select this action to replace the Desktop PC item with the Mobile Device item. 

  Select this action to skip and not replace either item. 
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2. When you have selected the appropriate action for each item in the list, click Synchronize Now to 
carry out the actions you specified. 

NOTE: Since synchronization is at the field level, there won’t be any data conflict if different 
fields in the same record are modified on both the handheld and desktop PCs. The 
modified fields will be automatically updated. 
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5 
Folders Tab 

The Folders tab allows you to select the folders to synchronize between Microsoft Outlook and Pocket 
On-Schedule.  You can also set filters to synchronize only a subset of items.  

The left hand side of the dialog box shows the tree structure of the Microsoft Outlook folders on the 
desktop PC. Check the box next to the name of the folder in Microsoft Outlook that you would like to 
synchronize.  

 

Folder Tab Buttons 
• Refresh: Reloads the folder tree from Microsoft Outlook. 
• Deselect All: Removes check mark selections on all folders. 
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• Select All:  Checks all folders for synchronization. 
• Properties:  Displays the Name, Path and Database Type of the selected database when database 

name is highlighted. Highlight individual folders to view folder properties. 

Folder Selection 
The Folders Tab displays the available Outlook databases on the tree displayed in the Folders List.  
The sub-folders of a main personal folder will be displayed by pressing the + sign on the hierarchy to 
expand and display the sub-folders.  The folders that may be synchronized to Pocket On-Schedule will 
have selection boxes next to the folder name. Click on the box to select it for Synchronization. Click 
on the marked box to deselect it for synchronization.  You may also use the Select All button to mark 
all the available sub-folders for synchronization. 

 
 
 

 

Folder Properties 
Click on the Properties button to display the Properties for the selected folder. From the Properties dialog 
you can: 

List of Outlook Folders
List of Databases on 
Mobile Device 
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• Mark the folder for Synchronization 
• View the date and time of the last completed synchronization of the folder. It is not advisable for 

you to change this date and time, even though you can change this date and time. This may result 
in duplicate items or skipped items.  

• Reset the folders snapshot and synchronization history. Click on the Reset button to delete any 
record of previous synchronization actions. The next synchronization will be as if the folder is 
being synchronized for the first time. This may result in duplicate items. For more information on 
resetting database snapshots, see page 24. 

• Add and Remove filters for the folders. Click on the Filter button to select or create filters to use 
during synchronization. Synchronization filters are only applied to the mobile device. For 
example, if you synchronize using a filter for Contacts in California, only Contacts where State = 
California will be sent to the device. However, all newly added contacts will be transferred from 
the device to the desktop PC before being removed from the device. For more information on 
Synchronization Filters, see page 25. 

 
 

Database Mapping 
When performing synchronization of a folder for the first time, the following message will appear to 
notify you that a corresponding database on the mobile device has to be mapped to the database 
containing the folder that you would like to synchronize with on the desktop PC.  
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Click on OK to display the following screen that lists the available databases for synchronization. 
Highlight the appropriate handheld database from the list and then click on the OK button to the right. 
 

 
• OK button will map the highlighted database. 
• Cancel button will close Select Database dialog. 
• Refresh button will reload the database list from the device. 
• Properties button will display the Name, Path and database Type of the selected database. 

If you don’t see the desired database on the device you can add a new database to your handheld device by 
selecting the “New Database” option from the Pocket On-Schedule menu. Click Refresh to display the 
newly added handheld database. 
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Mapping can also be done by clicking on the previously selected database in the Device Database and 
Filters column.  

• Select the database name from the list to change the mapped database (Note: each database may 
only be mapped to one Outlook database (.pst file). 

• Select <None> to cancel the mapping for the selected Outlook database (.pst file). 
• Select <New> will bring up the Select Device Database dialog with the listing of available 

databases. This will also delete the snapshot if this database was previously mapped and may 
result in duplicate items being synchronized. 
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Merging 
When synchronizing a device database or folder to the desktop for the first time you will receive the 
following message that verifies how you wish to handle the initial merging of information 

• Selecting Yes will overwrite the device database information with the desktop records.  This 
should be used if you want all device records to be replaced with the desktop’s, and delete any 
records on the device database or folder that is not contained in the desktop database or folder. 

• Selecting No will merge both the device and desktop database or folder information.  This should 
be used if you have some records on the device that you wish to merge with the desktop database.  
This will also create duplicate records of those that were contained on both the device and the 
desktop.  

• Select Cancel if you don’t want to process this database at this time, or if you want to verify 
which merging option you want.  
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Resetting Database Snapshot 
On-Schedule Outlook Sync uses the snapshot of the database to verify that records have been changed 
since the last synchronization.  Only the changed record will then be processed instead of completely 
processing the database on subsequent synchronizations.    
You may need to reset the snapshot of the database: 

• If you want to overwrite all information on the device database with the desktop records. 
To reset the snapshot for the device database: 

• Select the database name (i.e. the root item) in the Folders tab of the On-Schedule Sync 
application 

• Click the Properties button to bring up the following dialog 
 

 
• Click Reset and you will receive a message asking to confirm deletion of the snapshot. 
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• Selecting OK will delete the previous snapshot and upon synchronization the database will be 

treated as if it is being synchronized for the first time and you will be asked which merging 
option you want to process with. 

 

Resetting Folder Snapshot 
 To reset a folder snapshot and synchronization history: 

1. Select the folder to reset 
2. Click on the Properties button to display the Properties for the selected folder. 
3. Click on the Reset button to delete any record of previous synchronization actions. The next 

synchronization will be as if the folder is being synchronized for the first time. This may result 
in duplicate items. For more information on resetting database snapshots, see page 24. 

 

 
 
 

Synchronization Filters 
Filters are a set of criteria used to screen data prior to synchronization. For example, you can simply create 
a filter that will select only the contacts in California. Then, from the folder properties button of the 
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On-Schedule Outlook Sync Folders dialog box, you can select that filter for the desired contact list. Only 
the contacts that match the filter criteria will be synchronized with the mobile device. 
Filters can therefore be created to restrict or control which records are synchronized with your databases 
and can be as simple as transferring only those people who live in a certain state, or as complex as 
transferring appointments that are scheduled for the past and next 14 days. 
 

 
 Clicking on the Filter button will display the Select Filter dialog box. 

 

1. Select the filter you wish to use and tap OK. The chosen filter will be applied to the current view. 
Filters are view specific, therefore, if you create a filter in the contact list, it will not be available in 
the task list. You can also manage your filters from this dialog box. Editing, Duplicating, or 
Deleting a filter is as simple as highlighting a filter and pressing the appropriate button. 
 
When in the Filter Editor dialog box, you can:  
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• Enter a name for your filter Under Filter Name. 
• Select a field from the list you wish to filter on. 

NOTE: Only fields from the current view will be available for use. 
• Choose an Operator to use. 
The different options are: 
        =         - Equal to 
        < >  - Not equal to 
        >  - Greater than 
        > =  - Greater or equal to 
        <  - Less than 
        < =  - Less than or equal to 
         

 
NOTE:   
• Tap OK to save your filter, or click on Cancel to cancel the operation. 

You can also create filters with multiple filter expressions using the “AND” or “OR” buttons. These 
buttons will only appear after the first filter expression has been added. The “AND” function will 
check that all expressions are satisfied while the “OR” function will display records that meet at least 
one of the filter criteria. 
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6 
Email Tab 

 
 

With the Email Options, you will be able to setup the synchronization of your Pocket On-Schedule Email 
folders to Microsoft Outlook on the desktop PC companion  

Options 
• If the To save space on my device, download all my messages as plain text is checked, the 

fonts and formats of your messages will be downloaded as plain text.  This can conserve memory 
space on your device.   
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o If the To save space, copy at most ___ KB characters box is checked, you can specify 
the maximum number of characters of an e-mail message that is to be downloaded to the 
mobile device. This will prevent unknowingly downloading extremely long messages, 
which may use up all the memory space on the mobile device. If this box is unchecked, 
then the entire e-mail message is transferred to the device.  

• If the Include file attachments box is checked, the synchronization engine will transfer any file 
attachments with the e-mail message.  If this box is unchecked, no file attachments will be 
transferred.  

o You can limit the attachments to transfer by checking and specifying Limit Attachment 
Size to __KB option.  If there is not enough memory space to download the attachment, 
it will not be included when the e-mail is transferred to the mobile device. (Note: Only 
attachments that are less than or equal to 64kb in size may be downloaded) 
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